
 
 

 - 1 – 

PCB Design Express 
 
 

Allegro/APD Artwork 製作原理及步驟 

 
相關電影檔 : No 

 
Date: 01/06/2004 
Author: Louise Huang 
Revision: 1 
PSD Version: All 
Cadence Taiwan   
http://www.cadence.com.tw/
http://www.pcbhighspeed.com/
http://sourcelink.cadence.com/
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.cadence.com.tw/
http://www.pcbhighspeed.com/
http://sourcelink.cadence.com/


 
 

 - 2 – 

PCB Design Express 
 
 
 

Allegro/APD Artwork 製作原理及步驟 

 
前言：為了讓用戶了解 Allegro/APD 製作 artwork 的原理，以及正確的製作程序。

本文包含下列章節： 
� 概要  

� Vector-Based Artwork  
� Raster-Based Artwork  
� 製作Vector-Based Artwork 步驟 
� 製作Raster-Based Artwork步驟  

� Shapes and Vector-Based Artwork 
概要 

Artwork 是製造 PCB 所需要用的一組影像底稿，PCB Layout 完成後，將圖形製作

成 Artwork 檔，提供給 PCB(或 Substrate)製造廠商，這個步驟我們稱為製作 Artwork 

(Artwork process)。 
Artwork 可以為正片格式或負片格式，正片格式-將有圖形的部份例如( connect 

lines, pads, and shapes 等)繪成黑色，沒有圖形的則為空白。負片格式則反之，有圖

形部份是空白，沒有圖形部份則為黑色。  

artwork 的繪圖模式有 vector-based(向量式繪圖機) 和 raster-based(光柵式繪

圖機)兩種。這兩種繪圖都可以繪出正片格式和負片格式的 artwork。這兩種格式

Allegro/APD 都提供。 
製作 Artwork 的各種輸入及輸出檔案  

Allegro/APD 執行 Artwork 指令時，會依照環境變數 ARTPATH 所指定的路徑搜尋

art_aper.txt(鏡頭表)和 art_param.txt(參數檔)兩個檔案，將參數檔的設定值加到

Artwork Control Form 的 General Parameters 表格內。每當你修改任何參數值之後，

新的參數檔將被存到目前的工作目錄之下。  

執行 artwork 步驟的輸入檔： 
� Aperture File(鏡頭表) ：檔名 art_aper.txt (只有 vector-based 繪圖機格式

才需使用)  
� Parameter File(參數檔) : 檔名 art_param.txt，這個檔案描述所使用的繪圖

機及 artwork 輸出格式。採用 vector-based artwork 時，要一併將鏡頭表,參
數檔以及所有的 artwork 檔交給 PCB 製造商。 

� Film Control data (底稿記錄)：這組資料是記錄在 board file 內，每一個底稿
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它包含 Film name 及其所開的圖層。 

Artwork 輸出檔 
� Artwork 製作記錄檔 :檔名 photoplot.log,記錄製作 artwork 過程的訊息。執

行 Artwork 製作指令後，不管成功與否都必需查看這個檔案，以了解製作過程有

任何問題或警告訊息以及結果。 

� Artwork 檔:檔名<film name>.art 完成後的所有 artwork files。 
MDA 格式的輸出檔  

若 Artwork 包含 antipads 和 thermal flashes 時，輸出 McDonald Dettwiler 
(MDA) 格式的 film 會產生兩個 artwork files。一個是<film name>.art 另一個是

<film name>_s.art。 
MDA 格式使用 paint(塗上)和 scratch(刮除)兩種指令. 附加” _s”的檔案即是使用

scratch 指令。 

Vector-Based Artwork 
Vector-based artwork 是較舊式的繪圖方式。這種繪圖機有一個轉盤，裝上各種鏡

頭。繪圖機的光束透過鏡頭將圖形畫到底下的感光底片上。 

vector-based 繪圖機，讀取 artwork 檔案並依照指令選取鏡頭，在指定的座標位置移動

光束或快閃一下將圖形畫出來。這種格式的檔案又稱為 Gerber data。 
備註：由於本文包含非 Gerber formats，因此用“artwork”統稱底稿檔案。除非特別指

定為 Gerber format。 
Vector-based artwork 模式，對於畫 shapes，先選擇較小的鏡頭畫 shape 外框，

再用較大的鏡頭填滿 shape 內部。因此採用 vector-based artwork ，對於銅鉑面的圖

層你將會面臨下列問題： 

� 正片或複雜式的 shapes 將使得繪圖處理時間較長而且檔案很大 
� 如果圖形間距太小，沒有足夠小的鏡頭，可以精確的畫出這樣的圖形部份，則這

個 shape 就作不出來。Allegro/APD 稱這種情況為 “can’t fill shape” 
problem。 

這種問題可以採用負片出圖方式來解決，若一定要用正片出圖的話，則必需修改

shapes將有問題的部份排除，才能順產生Artwork。Raster-based artwork則不會有這

個問題，詳細請參考shapes and Vector-based Artwork。 

Vector-Based Pad-Type Behavior 
至於決定 Pad-Type 的方式，Allegro/APD 製作 artwork 時，會採用 regular、

thermal、 或 antipad 三種 pad type。對於 Vector-Based artwork，是依照出圖格

式來決定採用那種 Pin-Type。 
� 正片格式的 artwork 一率採用 regular pad。 
� 負片格式的 artwork，若 pins 和 vias 與 shape 相連則採用 thermal pad,不

相連則採用 antipad。 
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Vector-Based Plotter Types 

Allegro/APD 提供兩種 vector-based 繪圖格式： 

� Gerber 6x00 – vectorizes arcs 
� Gerber 4x00 – supports arcs 

詳細請參考：製作Vector-Based Artwork步驟

Raster-Based Artwork 
Raster-based artwork 是一種較新的 artwork 繪圖方式，這種處理方式，先將圖

形影像位置以暗(dark)、明(clear)格式存到記憶體中，然後再用雷射掃描出圖. 
這種繪圖處理方式，能將一個大的暗的區域所包含的明的區域套在一起，組合成正確的圖

形。例如:一個 shape 內會包含許多的 void，artwork 先以暗來描述 shape 範圖，然後

以明描述所包含的 void 部份，最後再將暗和明套在一起後，就成為正確的圖形影像。 
這種方式，繪圖機不需要來來回回的移動以填滿 shape，比 Vector-Bases 方式較省時、

資料量也小，而且也沒有”Can’t fill shape”的問題了。 Raster-based 繪圖機可以塗滿

小於 1 mil 的區域。  

Raster-Based Pad-Type Behavior  
Allegro/APD 進入 artwork 指令時，對每一個 film record 都先設定成

Vector-based pad behavior。 
對於 raster-based artwork，如果不採用 Vector-based pad behavior 那麼碰到負片

的 shape，會造成甜甜圈式的 pads。 Cadence 建議您採用 Vector-based pad behavior.
除非您想要產生甜甜圈式的 pads.  
下圖為 raster-based 負片 artwork 採用 Vector-based pad behavior 的例子： 
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下圖為 raster-based 負片 artwork 不採用 Vector-based pad behavior 的例子： 

 

小心：由於 Allegro/APD 並不會檢查 regular pad 對 antipad 大小的距離。因此採用

負片出圖時，要注意，所有的 antipads 必需大於 regular pads 以保持安全距離。 

Raster-Based Plotter Types  
Allegro/APD 提供下列三種 raster-based 繪圖機格式輸出:  

� Barco DPF 
� Gerber RS-274X 
� McDonald Dettwiler MDA 

詳細請參考：製作Raster-Based Artwork步驟
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製作 Vector-Based Artwork 步驟 

 產生 Photoplot Outline(optional) 

Ð 
 設定參數  

Ð 
 建立底片稿(film record)  

Ð 
 產生 Apture Table  

Ð 
 存檔  

Ð 
 製作 artwork  

Ð 
 查看 photoplot.log  

Ð 
 檢查 artwork  

� 產生 Photoplot Outline 
Photoplot outline 是 artwork 的圖框。在製作 artwork 時，將會依照 photoplot 

outline 為圖形範圍。 
你可以使用 Setup>Areas> Photoplot Outline 指令定義 Photoplot outline。 
這個步驟不是絶對必要的，如果你沒有定義 Photoplot outline 的話，在執行 artwork

時，會以 drawing extents 作為 artwork 圖框。 
旋轉 Artwork Data 

下圖舉例說明 photoplot outline 和原點位以及製作 artwork 要旋轉時，將以

photoplot outline 的中心點為旋轉點，如果沒有建立 photoplot outline 的話，將以

drawing extens 的中心點為旋轉點。 

 
Mirroring Data 
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下圖舉例說明，製作被 mirror 的 artwork 時，也是以 photoplot ouline 或 drawing 

extens 中心點為 mirror 點。 

 
注意：有些CAM工作站並不支援這項功能，因此無法正確顯示Cadence所提供的artwork 
data。 
製作 artwork 
1. 設定參數 

1-1 開始製作 artwork，選擇指令 Manufacture – Artwork 
1-2 選擇在 Artwork Control Form 上的 General Paremeters，出現如下圖所示

的參數表： 

 
1-3 參數說明： 
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� Device Type－選擇 Gerber 6x00(現在大概很少用 Gerber 4X00 格式) 
� Film Size Limits fields－指定底稿範圍，如果發現有圖形超過範圍時，將會有

警告訊息記録在 photoplot.log file。 
� Error Action 指定錯誤發生時處理方式。選擇 Abort film 只停掉這張 film，繼

續執行其他的 films。選擇 Abort all 則停止不再處理其他的 films.錯誤狀況，將

會被記錄到 log 檔內。 
� Output unit-指定 artwork 輸出單位。 
� Format 指定座標格式，整數位數（integer places）以及小數位數（decimal 

Places）其範圍分別為 0 到 5 位。它必須參考設計資料庫的使用單位及精確度

（accuracy）而設定。 
例如： 

Database unit  accuracy Gerber output unit Integerr,decimal 
Mils             0            inch         2,3 
Mils             1            inch         2,4 
Mils             2            inch         2,5 
Micron           0            milimeter    2,3 
Micron           1            milimeter    2,4 

注意：若小數位數不夠時，將會造成 artwork 不精確。 
� Scale Factor for Output－選擇 Gerber file 輸出比例，通常為１。 

2. 建立底片稿(film record) 
依照製造 PCB 所需要的底稿，每一張底稿都是一個 film recod。它包含 

� film name 
� 選擇那些 class/subclass 的圖形資料 
� 繪圖方式為正片或負片 
� 參考原點座標等 

詳細步驟如下： 

2-1 先選擇 Film Control 表格如下： 
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2-2 查看 film 內容 －用滑鼠點在 film name。 
2-3 按右鍵，選擇 Display 指令。Allegro/APD 視窗立即顯示這張 film 的圖形內容。 
2-4 必要的話，可以增加或減少圖層以符合正確的底稿所需資料。然後選擇 Match 
Display，將現在畫面所開啓的圖層自動更新到這張 film 內容。 
2-5 依照下列步驟，新增一張 film(例如 silk_top)。 
 2-5-1：在 Allegro/APD 畫面中，開啓這張 film 的所有圖層。 
 2-5-2：選擇最後一張 film，按右鍵選擇 Add。將彈出 Enter new film form
如下 

 
 2-5-3：輸入 film name 後按 OK，新的 film record 增加完成。 
 2-5-4：展開 film 內容，正是目前所開啓的圖層。 
2-6 定義 film option－逐一的設定每一張 film 的輸出方式如下： 
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 2-6-1：選擇 film，在 film option 部份的選項如下： 
� Film Name－顯示被選到的 film name。 
� Rotation－指 artwok data 的旋轉角度。 
� Offset X Y－指定原點徧移值。 
� Plot mode－指定以正片或負片出圖，除了 plane 可以選擇負片之外，其

它都必需以正片出圖。 

� Undefined LineWidth－指定 Line Width 為 0 的圖形，繪圖線寛。(例如 
text, assembly and silkscreen lines)。 

� Film Mirrored －指定 artwork 是否要作 mirriror。 
� Full Contact Thermal-Reliefs－指定負片中的 Thermal-Refiefs 均以全

導通方式處理。這是個特別的 artwork 處理功能。它並不會修改到 design 
database。 

� Suppress Unconnected Pads 移除內層沒有走線的 pads 或 vias (只針對

走線的內層)。這項功能對於 Internal Layer 為 Fixed 的 padstack 無作用。 
� Draw Missing Pad Apertures－沒有可用的 aperture 的 pads 直接用畫

的。 

� Use Aperture Rotation－表示 Gerber data 採用旋轉 aperture 角度。 
注意：有些 CAM 工作站沒有讀 Apture 角度的功能，因此選擇使用這個選項必需先和 PCB
製造商溝通好。選擇 raster-based 格式則不會有這個問題。 

詳細請參考 Vactor-based artwork 和 raster-based artwork 優缺點比較。 
� Suppress Shape fill－這個選項只針對負片模式有效，詳細請參考製作負

片模式的 vector-based artwork。 
3. 產生 Apture Table 

3-1：按 Artwork Control Form 底部的 Apertures 按鈕。彈出的 Edit Aperture 
Wheels form 如下： 
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3-2：選擇 Edit 按鈕，接著出現 wheel 1 Edit Aperture Stations form 。 
3-3：選擇和 Artwork 參數表所定義相同的 unit。 
3-4：選擇 Auto 按鈕，將有兩種選項分別為 with rotation 以及 without rotation。

依照步驟 2-6 是否使用 Use Apture Rotation，是的話則必需選擇 With Rotation；

否則就選擇 Without Rotation。 
3-5：Allegro/APD 將自動產生這個 design 所有的 Apture list 如下： 

 
3-6：以手動方式增加 aperture 則選擇 Add 按鈕然後再選擇適當的 aperture 並輸

入對應的 station number。對於 station number 或 aperture type 作排序。 
3-7：選擇 OK 按鈕將存檔為 art_aper.txt. 
注意：使用 15.x 以上版本，若有 dynamic shapes out of date 時會出現 Dynamic 
Shapes Need Updating...的按鈕。如下： 

 
選擇這個按鈕立即彈出 Drawing Option form 
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選擇 Update to Smooth 按鈕執行。待完成後，按 OK。才能繼續製作 Artwork。 

4. 存檔－將設定好的 film records 及其參數存在 design file。 
5. 製作 Artworks。 

5-1：在製作 artwork 之前，必先確認 design 没有 DRC 錯誤，也没有 database 
error。Film Control Form 左下方的 check database before artwork，選擇在

作 artwork 之前作一次 database 檢查，如果有錯誤的話，會有訊息出現，並且停

止執行。你必需先執行 Tools>Database Check 將問題解決後再繼續執行。 
5-2：選擇要輸出的 films 後選擇 Create Artwork 按鈕執行產生 artwork files。 
5-3：待出現 Plot generated 在 Artwork Control Form 下方的 message window。  
所有的 artwork files 都會以其 film name 加附檔名.art 存在工作目錄下。 

6. 按 Viewlog…按鈕查看 photoplot.log 內容，以了解 artworks 轉換過程 
7. 將 artwork 讀到 Allegro/APD 作檢查。 

使用 File > Import >Artwork 指令讀回 Vector-based artwork files 必需要

parameters file 以及 Aperture file。詳細步驟如下： 
7-1：準備工作－如果要將 artwork 讀到新的檔案則開啓新檔。 
7-2：建立新圖層，讓 artwork 分別讀到這些圖層。 

7-2-1 選擇 Setup > Subclasses 指令。 
 7-2-2 選擇 Manufacturing Class。 
 7-2-3 在 New Subclass field, 輸入 subclass name 按 Enter 或 Return 
鍵，完成輸入。 
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 7-2-4 重複上一步驟增加所需要的圖層後按 OK 結束。一切準備就緒，將

開始輸入 Artworks。 
7-3：將 Artwork Files 讀到 Allegro 

 7-3-1：選擇 File > Import > Artwork 出現 Load Gerber form 。 
 7-3-2：在 Class 及 Subclass 欄位內分別選擇對應到 7-2 所新增的圖層

上。 

 7-3-3：按 Browse 按鈕，選擇要讀入的 artwork 檔。 
 7-3-4：選擇 Display Pad Targets。才能看到 pads。 
 7-3-5：按 Load File 按鈕。 
7-3-6：將出現的方框，移動滑鼠到適當的位置點一下，Artwork 立即被放到指

定的位置。 

7-3-7：重複上述步驟讀入 artwork files。完成後按 OK 離開。 
製作 Raster-Based Artwork  

 產生 Photoplot Outline(optional) 

Ð 
 設定參數  

Ð 
 建立底片稿(film record)  

Ð 
 存檔  

Ð 
 製作 artwork  

Ð 
 查看 photoplot.log  

Ð 
 檢查 artwork  

� 產生 Photoplot Outline 
Photoplot outline 是 artwork 的圖框。在製作 artwork 時，將會依照 photoplot 

outline 為圖形範圍。 
你可以使用 Setup>Areas> Photoplot Outline 指令定義 Photoplot outline。 

這個步驟不是絶對必要的，如果你沒有定義 Photoplot outline 的話，在執行 artwork 時，

會以 drawing extents 作為 artwork 圖框。 
旋轉 Artwork Data 

下圖舉例說明 photoplot outline 和原點位以及製作 artwork 要旋轉時，將以

photoplot outline 的中心點為旋轉點，如果沒有建立 photoplot outline 的話，將以

drawing extens 的中心點為旋轉點。 



 
 

 - 14 – 

PCB Design Express 

 
Mirroring Data 

下圖舉例說明，製作被 mirror 的 artwork 時，也是以 photoplot ouline 或 drawing 
extens 中心點為 mirror 點。 

 
注意：有些CAM工作站並不支援這項功能，因此無法正確顯示Cadence所提供的artwork 
data。 
製作 artwork 
1. 設定參數 

1-1 開始製作 artwork，選擇指令 Manufacture – Artwork 
1-2 選擇在 Artwork Control Form 上的 General Paremeters，出現如下圖所示

的參數表： 
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1-3 參數說明： 
� Device Type－選擇 Gerber RS274x 或 Barco DPF 或 MDA 等 
� Film Size Limits fields－指定底稿範圍，如果發現有圖形超過範圍時，將會有

警告訊息記録在 photoplot.log file。 
� Error Action 指定錯誤發生時處理方式。選擇 Abort film 只停掉這張 film，繼

續執行其他的 films。選擇 Abort all 則停止不再處理其他的 films.錯誤狀況，將

會被記錄到 log 檔內。 
� Output unit-指定 artwork 輸出單位。 
� Format 指定座標格式，整數位數（integer places）以及小數位數（decimal 

Places）其範圍分別為 0 到 5 位。它必須參考設計資料庫的使用單位及精確度

（accuracy）而設定。 
例如： 

Database unit  accuracy Gerber output unit Integerr,decimal 
Mils             0            inch         2,3 
Mils             1            inch         2,4 
Mils             2            inch         2,5 
Micron           0            milimeter    2,3 
Micron           1            milimeter    2,4 
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注意：若小數位數不夠時，將會造成 artwork 不精確。 

� Scale Factor for Output－選擇 Gerber file 輸出比例，通常為１。 
2. 建立底片稿(film record) 
依照製造 PCB 所需要的底稿，每一張底稿都是一個 film recod。它包含 

� film name 
� 選擇那些 class/subclass 的圖形資料 
� 繪圖方式為正片或負片 
� 參考原點座標等 

詳細步驟如下： 

2-1 先選擇 Film Control 表格如下： 

 
2-2 查看 film 內容 －用滑鼠點在 film name。 
2-3 按右鍵，選擇 Display 指令。Allegro/APD 視窗立即顯示這張 film 的圖形內容。 
2-4 必要的話，可以增加或減少圖層以符合正確的底稿所需資料。然後選擇 Match 
Display，將現在畫面所開啓的圖層自動更新到這張 film 內容。 
2-5 依照下列步驟，新增一張 film(例如 silk_top)。 
 2-5-1：在 Allegro/APD 畫面中，開啓這張 film 的所有圖層。 
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 2-5-2：選擇最後一張 film，按右鍵選擇 Add。將彈出 Enter new film form
如下 

 
 2-5-3：輸入 film name 後按 OK，新的 film record 增加完成。 
 2-5-4：展開 film 內容，正是目前所開啓的圖層。 
2-6 定義 film option－逐一的設定每一張 film 的輸出方式如下： 
 2-6-1：選擇 film，在 film option 部份的選項如下： 
� Film Name－顯示被選到的 film name。 
� Rotation－指 artwok data 的旋轉角度。 
� Offset X Y－指定原點徧移值。 
� Plot mode－指定以正片或負片出圖，除了 plane 可以選擇負片之外，其

它都必需以正片出圖。 

� Undefined LineWidth－指定 Line Width 為 0 的圖形，繪圖線寛。(例如 
text, assembly and silkscreen lines)。 

� Film Mirrored －指定 artwork 是否要作 mirriror。 
� Full Contact Thermal-Reliefs－指定負片中的 Thermal-Refiefs 均以全

導通方式處理。這是個特別的 artwork 處理功能。它並不會修改到 design 
database。 

� Suppress Unconnected Pads 移除內層沒有走線的 pads 或 vias (只針對

走線的內層)。這項功能對於 Internal Layer 為 Fixed 的 padstack 無作用。 
� Vector-Based pad behavior－Default 為 on。 
詳細請參考Vector-Based Pad-Type Behavior

注意：使用 15.x 以上版本，若有 dynamic shapes out of date 時會出現 Dynamic 
Shapes Need Updating...的按鈕。如下： 

 
選擇這個按鈕立即彈出 Drawing Option form 
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選擇 Update to Smooth 按鈕執行。待完成後，按 OK。才能繼續製作 Artwork。 

3. 存檔－將設定好的 film records 及其參數存在 design file。 
4. 製作 Artworks。 

4-1：在製作 artwork 之前，必先確認 design 没有 DRC 錯誤，也没有 database 
error。Film Control Form 左下方的 check database before artwork，選擇在

作 artwork 之前作一次 database 檢查，如果有錯誤的話，會有訊息出現，並且停

止執行。你必需先執行 Tools>Database Check 將問題解決後再繼續執行。 
4-2：選擇要輸出的 films 後選擇 Create Artwork 按鈕執行產生 artwork files。 
4-3：待出現 Plot generated 在 Artwork Control Form 下方的 message window。  
所有的 artwork files 都會以其 film name 加附檔名.art 存在工作目錄下。 

5. 按 Viewlog…按鈕查看 photoplot.log 內容，以了解 artworks 轉換過程 
6. 將 artwork 讀到 Allegro/APD 作檢查。 

使用 File > Import >Artwork 指令讀回 Vector-based artwork files 必需要

parameters file 以及 Aperture file。詳細步驟如下： 
6-1：準備工作－如果要將 artwork 讀到新的檔案則開啓新檔。 
6-2：建立新圖層，讓 artwork 分別讀到這些圖層。 

6-2-1 選擇 Setup > Subclasses 指令。 
 6-2-2 選擇 Manufacturing Class。 
 6-2-3 在 New Subclass field，輸入 subclass name 按 Enter 或 Return 
鍵，完成輸入。 
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 6-2-4 重複上一步驟增加所需要的圖層後按 OK 結束。一切準備就緒，將

開始輸入 Artworks。 
6-3：將 Artwork Files 讀到 Allegro 

 6-3-1：選擇 File > Import > Artwork 出現 Load Gerber form 。 
 6-3-2：在 Class 及 Subclass 欄位內分別選擇對應到 7-2 所新增的圖層

上。 

 6-3-3：按 Browse 按鈕，選擇要讀入的 artwork 檔。 
 6-3-4：選擇 Display Pad Targets。才能看到 pads。 
 6-3-5：按 Load File 按鈕。 

6-3-6：將出現的方框，移動滑鼠到適當的位置點一下，Artwork 立即被放

到指定的位置。 

6-3-7：重複上述步驟讀入 artwork files。完成後按 OK 離開。 

Shapes and Vector-based artwork 
採用 Vector-based artwork 對於 shapes 的處理，正片和負片處理方式不同。 

詳細說明如下： 

� 正片繪圖模式－直接畫出圖形，在製作 artwork 時較為簡單，不易出錯。缺點是

資料量大，而且會有 can’t fill shapes 的問題。 
� 負片繪圖模式－把選到的圖形反相畫出，原來為塗滿的 shape 不畫出，只畫出原

來為空白的避開區(voids)。這種方式可以解決資料量大，處理時間太長以及

can’t fill shapes 的問題。但採用這種方式卻有個問題－如果在 shape 內包含

有其他的圖形（例如：clines,text ,pads 或較小的 shapes 等）將會被遺漏。 
� Raster-based artwork 對於正片 shape 或負片 shape 對於資料量或處理時間

都一樣，沒有差別，也沒有 can’t fill shape 的問題。 
因此對於複雜的 plane 層，建議採用 rsater-based 正片方式作 artwork。 

注意：Shape 對 pins 和 vias 的 DRC 檢查方式也有分正、負片的檢查模式，如果以正片

出圖的話，在 cross-section 的 planeDRC as photo Film Type 要定義成 positive。若

以負片出圖的話，則必需定義成 negative。 
製作負片模式的 vector-based artwork： 

以下是 Allegro/APD 製作負片的方式： 
� 增加另一個外框－這個框是在 pcb 外框再往外擴 100mils 它參考的參數為

Shape Bounding box(default=100mils/2540micron)。 
� 將外框到 shape 之間塗滿。 
� 所有 shapes 為空白。 
� 所有和 shapes 連接的 pins 和 vias 以 thermal-relief 或 flash symbol 畫出。 
� 所有和 shapes 不連接的 pins 和 vias 以 anti-pads 畫出。 
� 在vector-based 負片artwork，如果shapes內包含下列圖形的話將會被遺漏： 
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� pads 不在 shapes 之內的部份。 
� 線 
� 文字 

� board outline 的截角及切口等 
� 包含在 shapes 之內的其他 shapes 

通常我們建議您對於這些複雜的 plane，採用正片出圖，如果擔心資料量太大及 can’t 
fill shape 的問題，建議採用 raster-based 格式。 

如果您一定要採用 vector-based 負片格式的話，必需注意下列步驟： 
� 在 film record 增加 anti-etch 的圖層。 
� 勾選 Suppress shape fill。 
� 必需用 anti-etch 塗满 shape 到 outline 的部份 
� shape 裡面的 void 必需用 anti-etch 塗滿。請參考下圖： 

 
Thermal-relief pads 與 vector-based artwork 

在 14.2 版以後，製作 vector-based artwork 負片時，對於 thermal-relief pads
的處理有兩種方式： 

� 採用 old-style-flash-symbols 的 database－製作 vector-based 負片採用這

種模式的話，只是在 padstack 定義 thermal-relief pad name，不需要在

Allegro 資料庫建立 flash symbols。 
� 採用 WYS/WYG 負片的 database－則必需先建立 flash symbols。 
關於 WYS/WYG 負片的詳細說明請參考中文版 FQ&A :花孔(Flash Symbol)轉換設

定；或英文版的 Migration Guide for PCB and IC Packaging Release 
14.0,14.1,14.2 的”Migrating Flash Symbols”. 
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讀入 old-style-flash-symbol 的 artwork，必需勾選 display pad targets，而

thermal-relief pads 將以三角形顯示，而 anti pads 將以圓形顯示。下圖為讀入一個

old-style-flash symbols negative artwork 

 

製作負片模式的 raster-based artwork： 
製作 raster-based 負片 artwork 在選擇 film 內容與正片方式相同，不需要選擇

anti-etch。唯一必需先要有 flash symbol。 
讀入 raster-based 負片 artwork 時，將可以直接看到 thermal-relief pads 和

anti-pads。如下圖： 
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製作 Vector-Based 正片 Artwork 

以正片模式繪製vector-based artwork，繪圖機透過aperture來來回回的將shape
塗滿。因此處理起來資料量很大，也很費時。 

正片 Artwork 畫 shape 的規則 
Vector-based 畫正片模式 shape 採用下列規則： 
先用較小的 aperture 較精確的描出 shape 外框，然後再用高效率的模組塗滿 shape

內部使得資料量較小，處理時間也快。Allegro/APD 塗滿 shape 的規則略有不同，如下： 
Allegro 使用大於 3 mils 偶數值的 apture 描 shape 外框。 
APD 則使用最小的 line aperture 描出 shape 及 void 外框。Aperture 的中心點正

好畫在外框上，因此最後實際的外框正好以 1/2 的線寛往內外塗滿。 
接著逐漸選擇較大的 aperture 將 shape 內部塗滿。請參考下圖： 

 
 
控制 artwork 檔案大小 

對正片模式的 shapes 執行 artwork check 可以有效的減小 artwork 資料量。

Allegro/APD15.0 版採用 static shape 可以使用 Shape>Manual Void>Element 檢查

shape 太窄而無法描出來的部份，並且會在這些有問題的地方用一個圓圈標記出來，這些

標記問題的圓圈被加在 MANUFACTURING/SHAPE PROBLEM 層。大小以及顏色和 

DRC 符號相同。 

 
 
 

 

本版 PCB Design Express 內容版權為 Cadence 益華電腦所有。 
© 2002 Cadence Design Systems, Inc. All rights reserved.  Cadence, Allegro, Concept HDL, 
Orcad Capture, Orcad Layout, PSpice, SPECCTRA and the Cadence logo are registered 
trademarks, and SPECCTRAQuest are the trademark of Cadence Design Systems, Inc.  All 
others are properties of their respective holders. 

 


	Vector-Based Artwork
	Vector-Based Pad-Type Behavior
	Raster-Based Artwork
	Raster-Based Plotter Types
	製作Vector-Based Artwork 步驟
	製作Raster-Based Artwork
	Shapes and Vector-based artwork

